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Notes on Site Usage and Cookies

= Notes on Site Usage
= How to Print

Notes on Site Usage

 Five years after a product is discontinued, its setup file is made unavailable.
The Online Manual remains available, but as a rule it is not updated.
* When viewing this site, note the following:

o For best results, enable JavaScript in your browser settings.

o To display web pages tailored to your environment, Canon may send one or more cookies to your
computer, smartphone, or tablet. Most browsers automatically accept cookies, but you can modify
your browser setting so as not to accept cookies. If you have set not to accept cookies, some of
the functions of this website may be inoperative.

o If you are using Compatibility Mode in Internet Explorer 8, some pages may not be displayed
correctly.

In this case, turn off Compatibility Mode.

» Reproduction, diversion or copying of any text, photo or image published in this site, in whole or in
part, is prohibited.

* In principle, Canon shall change or delete the contents of this site without prior notice to customers. In
addition, Canon may suspend or stop the disclosure of this site due to unavoidable reasons. Canon
shall not be liable for any damage suffered by customers as a result of changes in or deletion of
information in this site, or suspension/stoppage of disclosure of this guide.

» Although the contents of this site have been prepared with utmost care, please contact the service
center if you find any incorrect or missing information.

* In principle, the descriptions in this site are based on the product at the time of its initial sale.

* This site does not disclose the manuals of all the products sold by Canon. See the manual supplied
with the product when using a product that is not described in this site.

How to Print

Use the print function of your Web browser to print this site.

For Windows:

To set to print background colors and images, follow the steps below.

»» Note

* In Windows 8, print in the desktop version.

* In Internet Explorer 9, 10, or 11

1. Select £S3 (Tools) > Print > Page setup....
2. Select the Print Background Colors and Images checkbox.

* In Internet Explorer 8

1. Press the Alt key to display the menus.

Alternatively, from Tools, select Toolbars > Menu Bar to display the menus.
2. Select Page Setup... from the File menu.
3. Select the Print Background Colors and Images checkbox.



* In Mozilla Firefox

1. Select = (Menu) > Print > Page Setup....
2. Select the Print Background (colors & images) checkbox in Format & Options.

* In Google Chrome

1. Select = (Chrome Menu) > Print....
2. Select the Background graphics checkbox in Options.

For Mac OS:

To print background colors and images, follow the steps below to display the Print dialog options, then
select the Print backgrounds checkbox.

1. Click Print... from the File menu.

[v]

2. Click Show Details or . (Down Arrow).
3. Select Safari from the pop-up menu.

Safari H

Print backgrounds
Print headers and footers



Using This Online Manual

= Symbols Used in This Document
= Touch-enabled Device Users (Windows)

Symbols Used in This Document

A\ Warning
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

/A Caution
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

32 Important
Instructions including important information. To avoid damage and injury or improper use of the
product, be sure to read these indications.

»>» Note

Instructions including notes for operation and additional explanations.

Instructions explaining basic operations of your product.

»>» Note

* Icons may vary depending on your product.

Touch-enabled Device Users (Windows)

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"
with "press and hold."



Trademarks and Licenses

» Microsoft is a registered trademark of Microsoft Corporation.

» Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

* Mac, Mac OS, AirPort, Safari, Bonjour, iPad, iPhone and iPod touch are trademarks of Apple Inc.,
registered in the U.S. and other countries. App Store, AirPrint and the AirPrint logo are trademarks of
Apple Inc.

+ 10S is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

» Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Play and Picasa are
either registered trademarks or trademarks of Google Inc.

» Adobe, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB (1998) are
either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or
other countries.

» Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

»>» Note

» The formal name of Windows Vista is Microsoft Windows Vista operating system.

Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Computer, Inc. ("Apple") nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Apache License
Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION



1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity
authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code
control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for
the purpose of discussing and improving the Work, but excluding communication that is
conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of



their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent
litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the
Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and

2. You must cause any modified files to carry prominent notices stating that You changed the files;
and

3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that
You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at
least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or

different license terms and conditions for use, reproduction, or distribution of Your modifications,

or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS I1S" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of



goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.

END OF TERMS AND CONDITIONS

The following applies only to products supporting Wi-Fi.
(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.

* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS,"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.



Enter keywords in the search window and click E (Search).

You can search for target pages in this guide.

Entry example: "(your product's model name) load paper"

Search Tips

You can search for target pages by entering keywords in the search window.

Canon

Contents | * Mobes on Site Usage and Cockies

Online Manual

- series -

E Satup | E Change Preduct |

) Featured Topics

3% Important

This function may not be available in some countries/regions.

»» Note

The displayed screen may vary.
When searching from this page without entering your product's model name or your application's name,
all products supported by this guide will be considered for the search.

If you want to narrow down the search results, add your product's model name or your application's
name to the keywords.

Searching for Functions

Enter your product's model name and a keyword for the function you want to learn about
Example: When you want to learn how to load paper

Enter "(your product's model name) load paper" in the search window and perform a search
Troubleshooting Errors

Enter your product's model name and a support code

Example: When the following error screen appears
Enter "(your product's model name) 1003" in the search window and perform a search

10



»» Note

» The displayed screen varies depending on your product.

» Searching for Application Functions
Enter your application's name and a keyword for the function you want to learn about
Example: When you want to learn how to print collages with My Image Garden
Enter "My Image Garden collage" in the search window and perform a search

» Searching for Reference Pages

Enter your model name and a reference page title*
* You can find reference pages more easily by entering the function name as well.

Example: When you want to browse the page referred to by the following sentence on a scanning
procedure page

Refer to "Color Settings Tab" for your model from Home of the Online Manual for details.

Enter "(your product's model name) scan Color Settings Tab" in the search window and perform a
search

11



General Notes (Quick Menu)

Quick Menu is subject to the following restrictions. Keep these points in mind.

+ Refer to the Canon website for products supporting Quick Menu.

+ Available functions and settings vary depending on your scanner or printer. Internet connection is
required depending on the function to be used. Internet connection fees apply.

+ In this guide, descriptions are mainly based on the screens displayed when using OS X Yosemite
v10.10.

When Using Image Display

* When using Image Display for the first time, you must agree to the license agreement. When you
agree to the license agreement by following the procedure below, images saved in folders subject to
image analysis of My Image Garden will appear in Image Display.

1. Click the image displayed in Image Display.

2. Read the displayed license agreement, then click Yes.

3. The screen for selecting the folders to be subject to image analysis of My Image Garden appears;
click OK.

* When Image Display is not displayed, click === (Start Image Display) in the Shortcut Menu.

About Downloading My Image Garden

» To display recommended items in Image Display or to edit/print selected items, you need to download
My Image Garden. You can download My Image Garden from the Canon website.
Internet connection is required for downloading. Internet connection fees apply.

12



What Is Quick Menu?
» What You Can Do with Quick Menu
» Starting Applications from Quick Menu

» Shortcut Menu Operations

13



What You Can Do with Quick Menu

Quick Menu consists of Shortcut Menu, which allows you to start the functions you want to use with one
click, and Image Display, which plays recommended items and others in slide shows.

Quick Menu Screens

(1) (2)

. Image Display

= (1) Shortcut Menu

= (2) Image Display

(1) Shortcut Menu

The menu that you mainly use. Add frequently used applications, etc. to start them with one click.

Click . (Open Main Menu) to display the Main Menu in which all functions are displayed.

(2) Image Display

The screen in which slide shows are displayed. It is available when My Image Garden, an application
enriched with useful functions such as photo printing and scanning, is installed.

You can view the following items and images in a slide show.

* ltems of collages, calendars, etc. created automatically by the item recommendation function of My
Image Garden
* Images saved on the computer

When an item or image that you like is found, you can print or edit it with My Image Garden.

»» Note

» Refer to "Utilizing the Item Recommendation Function" for your model from Home of the Online
Manual for the item recommendation function of My Image Garden.

Related Topic

= Shortcut Menu
= Main Menu

14



= |mage Display
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Starting Applications from Quick Menu

In Quick Menu, you can start applications, open manuals, or access the Canon website, from the Shortcut
Menu or Main Menu.

= Starting from Shortcut Menu
= Starting from Main Menu

Starting from Shortcut Menu

Click a function icon saved to the Icon Bar to start an application, etc.

> Note

« If the function you want to use is not saved to the Shortcut Menu, access it from the Main Menu.
» Refer to "Main Menu" for how to save function icons to the Shortcut Menu.

1. On the Icon Bar in the Shortcut Menu, click the function icon you want to use.

The application starts or manual opens. Access to the Canon website starts depending on the function
icon you clicked.

»» Note

* When the Icon Bar is not displayed, click an arrow displayed around . (Open Main Menu).

Starting from Main Menu

All functions that can be started from Quick Menu are displayed in the Main Menu. Click a function icon to
start an application, etc.

1. In the Shortcut Menu, click . (Open Main Menu).

16



The Main Menu appears.

2. Click the function icon you want to use.

Manual &
Dovic
Irfarmation

Canon Quick Menu

The application starts or manual opens. Access to the Canon website starts depending on the function
icon you clicked.

»» Note

* When the function you want to use is not displayed, click [I Il (Back/Next) to display the
hidden icons.

Related Topic

= Shortcut Menu Operations

17



Shortcut Menu Operations

Add frequently used function icons and useful function icons from the Main Menu to the Shortcut Menu to
start the functions with one click. You can delete or rearrange function icons as needed.

= Adding Function Icons to Shortcut Menu
= Deleting Function Icons from Shortcut Menu
= Rearranging the Function Icons

Adding Function Icons to Shortcut Menu

1. In the Shortcut Menu, click . (Open Main Menu).

The Main Menu appears.

2. Drag the function icon you want to add and drop it onto the Icon Bar of the Shortcut
Menu.

18



Wab Services

Manual &
Dovion
Infarmastion

&

Modntonanca
-
=

Canon Quick Menu

The function icon is added to the Shortcut Menu.

»» Note

* You can save up to eight function icons to each side of the Shortcut Menu.
« Alternatively, in the Main Menu, control-click the function icon you want to add, then select Add

to Shortcut Menu from the displayed menu to add it.

Deleting Function Icons from Shortcut Menu

1. Drag the function icon you want to delete and drop it outside the Shortcut Menu area.

The function icon is deleted from the Shortcut Menu.

19



»» Note

« Alternatively, control-click the function icon you want to delete, then select Delete from
Shortcut Menu from the displayed menu to delete it.

* You cannot delete . (Open Main Menu).

Rearranging the Function Icons

1. Drag a function icon in the Shortcut Menu and drop it to the target place.

The function icon is moved to the dropped place.
Related Topic

= Shortcut Menu
= Main Menu

20



Quick Menu Screens
» Shortcut Menu
» Main Menu
*» Image Display
« Recommendation ltem List

» Preferences Dialog

21



Shortcut Menu

You can start applications, open manuals or Main Menu, or access the Canon website.

()

= (1) Icon Bar
= (2) Open Main Menu Icon

(1) Icon Bar

Icons of saved functions are displayed.

Point to a function icon to display the function description.

Click a function icon to start the application or open the manual, or access the Canon website.

(2) Open Main Menu Icon

Click . (Open Main Menu) to display the Main Menu.

Click an arrow displayed around the icon to show/hide the Icon Bar adjacent to the arrow.

In addition, control-click . (Open Main Menu) to display a menu containing the following commands.

Open Main Menu
Opens the Main Menu. Displays in front when already opened.

Add Start My Image Garden Icon

Place a checkmark to display g (Start My Image Garden) in the Shortcut Menu.
Add Start Image Display Icon

Place a checkmark to display E (Start Image Display) in the Shortcut Menu.

Help
Opens this guide.

Preference...
Displays the Preferences dialog.

22



Related Topic

= Shortcut Menu Operations

23



Main Menu

All functions that can be started from Quick Menu are displayed in this screen. Click a function icon to start
the application or open the manual, or access the Canon website.

To display the Main Menu, click . (Open Main Menu) in the Shortcut Menu.

Wb Sanvices

Mambar Login

D
Infarmation

Manual & ﬁﬂl

Modntononca

Canon Quick Menu

= (1) Category Menu Area
= (2) Function Icon Area
= (3) Model Name Area

= (4) Button Area

(1) Category Menu Area

A list of functions available on Quick Menu is displayed.

(2) Function Icon Area

Icons and names of functions that can be started from Quick Menu are displayed, sorted by category.

Up to five function icons are displayed per category. When there are six or more function icons, click [I I]
(Back/Next) to display the hidden function icons.

Point to a function icon to display the function description.
The NEW mark appears when there is new information.
In addition, control-click a function icon to display a menu containing the following commands.

Start
Starts the selected application, opens the selected manual, or accesses the Canon website.

Add to Shortcut Menu
Adds the selected function to the Shortcut Menu.

24



(3) Model Name Area

The printer/scanner model name registered in the Preferences dialog is displayed.

The model name display format varies depending on the registered printer/scanner.

Click to display the Preferences dialog.

(4) Button Area

m (Preferences Dialog)
Displays the Preferences dialog.

(Help)

Opens this guide.

H (Close)

Closes the Main Menu.

25



Image Display

Items created automatically by the item recommendation function of My Image Garden, or images saved on
the computer are displayed in a slide show.

Image Display < Il » | %

= (1) Slide Show Area
= (2) Button Area

(1) Slide Show Area
Click the Slide Show area to start My Image Garden.

(2) Button Area

(Recommendation Item List)
Displays a list of items that have been created by the item recommendation function so far.

»» Note

. (Recommendation Item List) may not be clicked while an item is being created or in some
other cases.

(Back/Next)

Click to display the previous or next item or image.

ﬂ ||| (Playback/Pause)

Plays or pauses the slide show.

ﬂ (Preferences)
Displays the following dialog.

You can set the slide show details, startup option, link with My Image Garden, etc.

26



Image Display

Transition Efect: Fade E
Image View: | Display entire image E
Display Speed: | Madium E
Display Image Display at startup
Click the butten below to use the item recommendation function.
Ikerm Recommendation Function Setup...,
Dalete 2l recommended items.
Dalete All
Cancal Ok

Transition Effect
Set the transition effect to apply when switching from one item or image to another in slide
shows.

Fade
ltems and images gradually appear.

Slide in
Items and images slide in from one side.

Zoom
Iltems and images are zoomed in as they are displayed.

Move
Iltems and images move randomly as they are displayed.

Image View
Set the item/image view in slide shows.

You can select Display entire image or Display based on short side of image.

»» Note

» This setting is not available when Zoom or Move is selected.

Display Speed
Set the speed (duration) of switching from one item or image to another in slide shows.

You can select Fast, Medium, or Slow.

Display Image Display at startup
Select this checkbox to display Image Display when Quick Menu starts.

Item Recommendation Function Setup...
Displays the following dialog.

27



Image Display

Enable the item recommendation function to automatically
create meyw recommandations from saved images.

Create recommendations

oK
Cispls
Click the bution below o use the itam recommandation function.
b Precammendation Function Sefup..,

Dalete all recommended items,

Db Al

Cancal OK

Select the Create recommendations checkbox to automatically create items such as collages
and calendars using information and images registered on My Image Garden.

»» Note

* When Display Image Display at startup is off and Create recommendations is on, Image
Display starts once every seven days.

Delete All
Deletes all items that have been created by the item recommendation function so far.

When you click Delete All, a confirmation screen appears; click Yes.

»» Note

* To delete recommended items individually, click E] (Delete mode) in Recommendation

Item List, then click ) (Delete) on the item you want to delete in the displayed screen.
Even if you delete an item, the image used for the item will not be deleted.

H (Close)

Closes Image Display.

28



Recommendation Item List

Displays a list of items that have been created by the item recommendation function so far. The items are
sorted by year, with the date of the latest image in the item regarded as the event date.

To display the Recommendation Item List, click (Recommendation Item List) of Image Display. Click an
item to start My Image Garden.

»>» Note

. (Recommendation Item List) cannot be clicked if there is no item.

(1) (2)
« 8 "a HE ﬁ EEfEE R

)
e =
ha 2

1--“ }

Image Display

= (1) Year of Event Area
= (2) Image Display Area
= (3) Button Area

(1) Year of Event Area

The years of the events are displayed. Click = (Down arrow) to display the next year. Click = (Up
arrow) to display the previous year.

(2) Image Display Area

ltems are displayed, sorted by event year. The items are listed from left to right, in chronological order.

Click [I Il (Back/Next) to display the hidden items.
»>» Note

» Point to an item to see it in a larger view.

29



(3) Button Area

(Back to Image Display)
Returns to the Image Display screen.

E] (Delete mode)
Switches to a screen for deleting items.

20

-

Image Display

Click ) (Delete) on an item to delete it.
2> Note

* You can return to Recommendation Item List by one of the following operations.

* Click E] (Delete mode) at the bottom right of the screen for deleting items.
* Click anywhere on the border of the screen.

» Even if you delete an item, the image used for the item will not be deleted.

+ Alternatively, you can delete all items via the dialog displayed by clicking m (Preferences) in
Image Display.
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Preferences Dialog

You can register a printer/scanner model, region, etc.

Display the Preferences dialog by one of the following operations.

+ Control-click . (Open Main Menu) in the Shortcut Menu, then click Preference... in the displayed
menu.

* Click m (Preferences Dialog) displayed at the bottom of the Main Menu.
* Click the printer/scanner model name displayed in the Registered Model Name area in the Main Menu.
* Click Preference... from the Canon Quick Menu.

»» Note

» The information set in the Preferences dialog may be sent to Canon when accessing a website, etc.
via Quick Menu.

Frefarances
Select Maodel
Printer: ﬂ
Scanner: @

Salect Your Place of Poesidenca

Region: USA, CGanada, Latin America
Country or Reglon: United States

Region or Country Settings

Legin Informatign

Use the Notices function

Cancel |

Select Model
Printer
Displays the printer model name. Select the printer you want to use.
Click ﬁ to display a list of Quick Menu compatible printers installed on your computer.
Scanner

Displays the scanner model name. Select the scanner you want to use.

Click ﬁ to display a list of Quick Menu compatible scanners installed on your computer.

»>» Note

« If your machine supports network connection, the scanner may appear for USB connection
and network connection separately. In that case, select one according to your connection
method.

e For USB connection: Canon XXX series
¢ For network connection: Canon XXX series Network

(Where XXX is the model name.)
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»» Note

« If an all-in-one inkjet printer is selected for Printer, the same printer will be automatically selected

for Scanner.

Select Your Place of Residence
Region or Country Settings
Displays the Region or Country Settings dialog in which you can set the Region and Country or
Region.

»>» Note
» Changes are applied when you click OK in the Region or Country Settings dialog.

Login Information
Login Settings
Displays the Login Settings dialog. You can save the Email address and Password registered
with CANON iMAGE GATEWAY.
When you save the Email address and Password, your login information will be sent
automatically from the next time you access CANON iMAGE GATEWAY to use the service or
register a product.

»» Note

+ This function is available only if you have already completed the CANON iMAGE GATEWAY user
registration.

Use the Notices function
Select this checkbox to allow Quick Menu to access the Canon website periodically and check for

update information automatically. If there is update information, the NEW mark appears on
(Notices) in the Main Menu. Click the icon to display a notice screen in which you can check the update
information.

22 Important

* In order to use this function, the following information will be sent to Canon: your product name, OS
information, regional information, language information, and information that you have agreed to

receive information periodically.
When you select this checkbox, a confirmation screen may appear. Read the contents, and if you
agree, click | Agree. If you do not agree, you cannot use this function.

OK
Applies the settings and closes the Preferences dialog.

Cancel
Closes the Preferences dialog without saving the settings.
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Troubleshooting

Printer/Scanner Does Not Appear in the List

Printers and scanners do not appear in the Select Model list of the Preferences dialog in the following

cases.

* A Quick Menu compatible printer/scanner driver is not installed on your computer.
» The printer/scanner driver installation is not complete.

Make sure that none of the above points apply, then display the Preferences dialog again.

7> Note

» See your printer/scanner manual for details on how to install the printer/scanner driver.
» The printer/scanner driver installation may not be complete in the following cases.

» The printer/scanner was not connected to your computer while installing the driver.
» The printer/scanner was off while installing the driver.
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How to Check the Version - Quick Menu -

You can check the version of Quick Menu by following the steps below.

1. Start Quick Menu.

=
2. Control-click \ﬂ (Canon Quick Menu) in the Dock.

3. Click About in the displayed menu.

The version information appears.

Canon Quick Menu
Vorsian
Copyright CANON ING.

®
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